
CALENDAR
March

13-19 — National Sunshine Week
17-18 — Ozark Press Association,
  Chateau on the Lake, Branson
31 — Russell Viers InDesign 
  workshop in Lamar

April
1 — Russell Viers InDesign and Photo-
  shop workshop in Lamar
10-12 — Newspaper Archive Summit,
  RJI, Columbia
14-15 — Missouri Advertising 
  Managers’ Association, Holiday Inn 
  Kansas City SE Water Park Hotel, 
  Kansas City
14-16 — Midwest Circulation Manage-
  ment Association, Rogers, Ark.
28 — Missouri Press Foundation Board 
  meeting, 2 p.m., MPA, Columbia
28 — Past Presidents and Spouses
  Dinner, 6 p.m., Grand Cru Restaurant,
  Columbia
29 — Social Media Workshop, Holiday
  Inn Express, Warrensburg

May
6 — Social Media Workshop, Kenneth
  Cowan Civic Center, Lebanon

June
3 — Southeast Missouri Press
  Association, Southeast Missouri
  State, Cape Girardeau
9-11 — Show-Me Press Association,
  Hannibal Quality Inn

July
20-23 — 50th Annual National
  Newspaper Association Government
  Affairs Conference, Washington, D.C.

September
8-10 — 145th Annual MPA Conven-
  tion, Hilton Convention Center 
  at Branson Landing, Branson
22-25 — National Newspaper
  Association Annual Convention
  and Trade Show, Albuquerque, N.M.

Political ads in papers are most believable, helpful

Tell this story — often!

Registration forms for coming MPA activities can be found at mopress.com/current_forms.php.

No. 1266  — 16 March, 2011

A survey by Pulse Research for the Missouri Press Association has shown for the 
third time that Missourians who voted in elections perceive political ads in newspa-
pers to be more helpful and more believable than ads in any other medium. Voters 
also perceive political ads in newspapers to be the least offensive.

Those are some of the findings of post-election surveys commissioned by MPA 
after the November elections in 2002, 2006 and 2010.

“The results of these surveys show that 
in spite of the volume of political advertis-
ing on television, radio and the internet, 
Missourians see newspapers as the best 
place to look when they want information 
to help them decide how to vote,” said 
Doug Crews, executive director of MPA.

Newspaper advertising works!
Advertisers — particularly candidates 

and issue promoters — are not getting this 
message often enough or clearly enough. 
Missouri Press staff works constantly to get 
this message across. It needs your help.

MPA has created house ads that you 
can use in your newspaper to make these 
points. They can be downloaded from 
http://www.mopress.com/Election_Survey.
php. 

This information also can be accessed 
through Facebook and Twitter:

http://www.facebook.com/
pages/Missouri-Press-Associa-
tion/154375874617599

http://twitter.com/ - !/MissouriPress.
If you want copies of the ads sent to 

you, contact the MPA office and they will 
be mailed or emailed to you: (573) 449-

4167; mopressads@socket.net.
Also on that website are links to the entire Pulse Research survey results — in-

cluding charts and other graphics — and a news release about the survey findings. 
(That release was emailed to your paper on Tuesday).

MPA urges its member newspapers to use this material in their newspapers and 
in their efforts to get local candidates to use them before elections. Use it constant-
ly. The message fades quickly if not repeated often.

medium in the post-election voter 
survey, increasing from 10% in 

2002 and 2006 to 19% in 2010.*

Newspaper
“Most Believable”

advertising is the

*Pulse Research Post Election Voter Survey
2002, 2006, 2010
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Send 4 copies of
every issue

Please check your subscription list 
to be sure Missouri Press Service is 
being sent four copies of every issue of 
your publication. 

These papers are part of your Mis-
souri Press Association dues. Missouri 
Press uses them to pull ad tearsheets 
to send to advertisers. 

Missouri Press cannot bill advertis-
ers or pay for adverting without the 
tearsheets immediately after ads are 
published.

InDesign, Photoshop
training in Lamar

Circulation meeting
April 14-16 in Arkansas

Workshops coming soon to Warrensburg, Lebanon

Learn how to use social media

Need help with a newspaper issue? Check the links at mopress.com/reporterslinks.php.

Russell Viers

(Agenda and registration form enclosed.)

Adobe trainer Russell Viers will give 
two workshops in Lamar on Thursday, 

March 31, and 
Friday, April 1. 

Thursday’s 
program will be 
“InDesign for 
Absolute Begin-
ners.” Friday’s 
will be “Build 
Your Newspaper 
Faster Using 
InDesign and 
Photoshop.”

Workshops 
will be held in 

the conference room of the Barton 
County Ambulance District. An agenda 
and registration form are enclosed.

Join Chad Jaennette, public 
relations manager from ABC, as he 
discusses recent newspaper rule 
changes and how they are shaping 
the industry. He will speak on Friday 
morning, April 15, at the 2011 Midwest 
Circulation Management Association 
Conference at the Embassy Suites in 
Rogers, Ark.

Here are other sessions the April 
14-16 conference will host:

 ● DSM Training with Stacey Peters.
 ● Postal Updates with Max Heath.
 ● Paywalls for Online Content with 

Conan Gallaty.
 ● Legal Matters with Michael 

Zinser.
 ● Secret Strategies of the Arkansas 

Democrat-Gazette with Larry Graham.
 ● Audience Building with Newel 

Jensen.
 Visit http://www.midwestcircula-

tion.com/resource_center.asp for 
MCMA Conference information and 
forms.

So what’s all this blogging and texting and tweeting all about? And what’s that 
Facebook anyway?

In case you didn’t know, 86 percent of businesses view social media as important 
to their business and marketing. Marketing is YOUR business. Isn’t it time you 
learned about social media?

Even if you pub-
lish a small newspa-
per in an isolated, 
rural community, 
you need to use 
and offer social 
media.   

How can you 
— or someone on 
your staff — learn 
how to do all that 
stuff? Here’s how!

If you can’t or 
don’t want to at-
tend, you should at 
least send some-
body to one of 
the Missouri Press 
Foundation work-
shops coming soon 
— Friday, April 
29, in Warrensburg 
and Friday, May 
6, in Lebanon. 
Sessions will be 
from 9:30 a.m. to 3 
p.m., and they cost 
only $40.

The Warrensburg 
Daily Star-Journal 
and Lebanon Daily 
Record are helping 
with these workshops.

Darren Heckman will be the trainer. He’s president of High 5 Communications 
in Jefferson City. High 5 is a marketing, public relations and planning firm that 
serves the retail, healthcare, education and association industries. (He spoke at the 
MPA Convention in October.)

Here’s what you’ll learn:
• Social Media 101 - the basics, the options and the reason for the social media 

explosion.
• The impact social media is having on the advertising world.
• Opportunities for your newspaper to use social media and the internet to in-

crease readership.
• Ways to generate revenue through social media and the internet.
Information and registration are enclosed.
Jump on this opportunity to learn and prosper!
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Missouri Press Association
Missouri Press Service

802 Locust St.
Columbia, MO 65201-4888

(573) 449-4167; FAX (573) 874-5894 
www.mopress.com

STAFF
Doug Crews: Executive Director, dcrews@

socket.net
Greg Baker: Advertising Director, gbaker@

socket.net
Kent Ford: Editor, kford@socket.net

Connie Whitney: 
cwhitney@socket.net 

and Jennifer Plourde:
jplourde@socket.net

Advertising Sales and Placement
Karen Philp: kphilp@socket.net

Receptionist, Bookkeeping
Kristie Williams: Member Services, 

Meeting Coordinator, 
kwilliams@socket.net

Rachael Heffner: Advertising, 
Graphic Design, rheffner@socket.net

Jean Maneke:
Legal Hotline Counselor

(816) 753-9000
jmaneke@manekelaw.com

Dawn Kitchell:
NIE & Education Director

(636) 932-4301; kitchell@yhti.net
Ron Cunningham:
Postal Consultant

(417) 849-9331; postalhelp@aol.com

MPA PRESIDENT: Joe May, 
  Mexico Ledger          
FIRST VICE PRESIDENT: Phil
  Conger, Bethany Republican-Clipper
SECOND VICE PRESIDENT: Mark 
  Maassen, The Kansas City Star 
SECRETARY: Bill Miller Jr., 
  Washington Missourian  
TREASURER: Jeff Schrag, Springfield
  Daily Events    
MPA DIRECTORS: Kevin Jones, 
    St. Louis American
  Jon Rust, Cape Girardeau 
    Southeast Missourian
  Dennis Warden, Gasconade County
    Republican, Owensville
  Kate Martin, Perry County 
    Republic-Monitor, Perryville
  Joe Spaar, The Odessan, Odessa
  Brad Gentry, Houston Herald
  Jim Robertson, Columbia Daily Tribune
  Linda Geist, Monroe City Lake Gazette
NNA REPRESENTATIVE: Trevor Vernon, 
    Eldon Advertiser
MPS PRESIDENT: Vicki Russell, 
    Columbia Daily Tribune 
VICE PRESIDENT: Jack Whitaker,
    Hannibal Courier-Post
SEC-TREAS.: Dave Bradley, St. Joseph
    News-Press
MPS DIRECTORS: Steve Oldfield,
    Adrian Journal
  John Spaar, The Odessan

Great ad training from two experienced presenters

AG sues city, police chief, mayor

MAMA will meet in K.C.

How can you find things on the MPA website, mopress.com? Click the “Site Map” link at the bottom of the page.

JEFFERSON CITY – Attorney General Chris Koster said Monday he has filed 
suit against the city of Lebanon for violating Missouri’s open records laws. Also 
named in the suit are Henry Luxem, city administrator; Constant P. “CP” Craig, 
mayor; and Joseph Brauer, chief of police.

Koster said in December 2010 Brauer sent an email to some employees of the 
police department informing them that the city council had reversed a police board 
decision to discipline an employee and indicating his disagreement with that deci-
sion.  

A few days later, an open records request was made seeking the email and related 
documents. The city of Lebanon denied the sunshine request, stating that the email 
was not a public record.  

In January 2011 the Attorney General’s Office sent Luxem a letter stating that 
emails sent on, received by, and retained on the city’s computers are public records 
and that the requested email must be disclosed under the Sunshine Law. The city 
continues to maintain the email is not a public record.

Koster said other concerns include problems maintaining proper police incident 
reports and releasing arrest reports when they are open records.

“Missouri’s Sunshine Law is crystal clear that both state and local governments 
must be open to the people,” Koster said. “Governmental bodies cannot make arbi-
trary rules to keep our citizens out of the process.”

Koster is asking the court to issue an injunction prohibiting the defendants from 
further violating the Sunshine Law, assess civil penalties up to $5,000 against each 
defendant, and require the defendants to pay court costs.

Don’t be misled by the name of the organization. The Missouri Advertising Man-
agers’ Association (MAMA) is for everyone involved with advertising and marketing 
at your newspaper, from the publisher to the greenest ad rep on the staff.

All of you have an opportunity to get ad sales training in April from two experi-
enced, top-notched trainers. Russell Vi-
ers, an Adobe trainer, is on the meeting 
agenda along with Tim Smith of Allen-
town, Penn.

MAMA will hold its annual meeting 
April 14-15 at the Holiday Inn Kansas 
City SE Water Park Hotel.  

Smith worked in the publishing busi-
ness for more than nine years and has 
been a newspaper industry trainer for 
more than eight years. He will speak on 
Thursday afternoon, April 14. 

Viers will speak Friday morning, April 
15. He has traveled the world extensively, 
with frequent stops in Missouri, showing 
people how to do their jobs easier and 
faster with the tools in their computers.

Smith’s presentation will focus on sales, communication and time management 
skills. Viers will talk about online advertising and creating great spec ads. 

The MAMA meeting will begin after lunch on Thursday and end just before 
lunch on Friday. On Thursday evening, MAMA Better Ad Contest awards will be 
presented.

An agenda and registration form are enclosed.
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Austin’s ‘Tales & Sales’ has daily themes 

Mix fun with classifieds

AP offers Cival War photos for 150th

Reporters Institute
at Poynter this summer

GateHouse to launch
apps for communities

Plenty of help for you
in MPA online Toolbox

MPA’s website, http://www.mopress.com, has archives of past issues of the Bulletin, eBulletin and Missouri Press News magazine.

The Austin (Texas) American-States-
man has in innovative section for clas-
sifieds: Tales & Sales. Monday through 
Friday, Tales & Sales combines engag-
ing content with sales information. It’s 
classifieds, but with Austin attitude and 
fun. 

Tales & Sales also features The 
Stuffologist – a savvy raconteur spinning 
the tales behind the myriad things Aus-
tinites do and don’t do (Work) or love 
and don’t love (Pets). The daily themes 
include Wheels on Monday, Work on 
Tuesday, Homes on Wednesday, Pets on 
Thursday and Stuff on Friday.

“We’re doing something different 
with this section,” says vice president 
of marketing Lisa Sullivan. The sec-
tion is created by the Stuffologist, who 
shares short stories and fun photos that 
showcase things people buy or sell, work 
people do and the stuff integral to their 
lives – including pets. “It’s a dynamic 
mixture of content and classifieds that 
gives it a unique flavor,” Sullivan said.

Also making an appearance in Tales 
& Sales are the comic strips “Doones-

bury” and “Mallard Fillmore.” KenKen – the hottest new puzzle since Sudoku – 
and SCRABBLEgrams satisfy readers who have a penchant for puzzles.

Community newspaper pub-
lisher GateHouse Media, Inc. has 
announced a partnership with 
Toronto-based Spreed Inc. to launch 
community-focused smartphone and 
iPad applications in its local markets.

The apps enable smartphone 
users in GateHouse’s local markets to 
read news from their local news-
papers, and will allow advertisers 
to reach users of smartphones in 
GateHouse markets.

According to Morgan Stanley 
Research, the smartphone market 
will grow to 1 billion units by 2013. 
Informa Telecoms 7 Media predicts 
that mobile advertising revenues will 
increase eight-fold by 2015 to around 
$25 billion.

Since 2007, SPJ has held the Re-
porters Institute program to benefit 
early-career journalists. Funded by 
the Sigma Delta Chi Foundation, 
the Reporters Institute brings 36 
reporters together for three days of 
training, networking and camara-
derie. Those in the first one to three 
years of their careers are invited to 
apply for the June 12-15 or July 10-13 
programs.

Before applying, it is important for 
applicants to make sure they will be 
able to participate if selected. Apply 
here: https://www.spj.org/ri-form.
asp.

The program will take place at The 
Poynter Institute in St. Petersburg, 
Fla. A submitted application does not 
guarantee a spot in either program. 
Those accepted to the program 
are responsible for a $300 registra-
tion fee and their travel to/from St. 
Petersburg.

If you have questions about the 
Reporters Institute, contact Heather 
Dunn at hporter@spj.org, (317) 927-
8000 ext. 204.

Visit the Newspaper Toolbox on 
the MPA website for articles and links 
about every facet of publishing a 
newspaper, from ad sales to legal is-
sues to photography.

Add the Toolbox to your browser 
bookmarks and refer to it any time 
you need some information or have 
a question.

NEW YORK—The Associated Press has compiled a special collection of histori-
cal photographs from the American Civil War for use in print and online commem-
orations of the War Between the States that began 150 years ago on April 12. 

From the Battle of Antietam to the “Devil’s Den” at Gettysburg, the collection 
of 55 photos captures the visual history of the four-year war. It depicts the soldiers, 
forts, encampments, battlefields and ruined cities of the American South. 

“As newspapers across the country plan their special Civil War sections, com-
memorative tabs and photo galleries for their websites, we urge them to include 
photos that capture the rich history of the Civil War,” said Randy Picht, AP’s prod-
uct manager for U.S. newspapers.

The collection of photos obtained from the Library of Congress and pulled from 
AP’s own archives includes portraits of Gen. Robert E. Lee, Gen. Ulysses S. Grant 
and abolitionist Frederick Douglass. Photos from the battles at Gettysburg, Chat-
tanooga and Fort Sumter are included, as well as an image from President Lincoln’s 
1865 funeral.

This special offer is available to newspapers, both daily and weekly, and affiliated 
publications, for purchase at a very affordable price by visiting this URL: http://ex-
posure.apimages.com/content/photos-american-civil-war-apimagescom.
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Cell phones in India playing ads

Listen to podcasts on advertising legal issues on the MPA website. Go to mopress.com/podcasts.php.

Track bills in legislature

Archiving digital news
a topic at April summit

Podcasts by MPA Hotline Attorney 
Jean Maneke are available at mopress.
com/Podcasts.php. 

Topics include the Missouri Sun-
shine Law, libel insurance, covering 
the courts, advertising issues, copy-
right and trademark.

Listen and learn

Track House and Senate bills at 
www.mo.gov.

House and Senate Joint Bill Track-
ing: http://www.house.mo.gov/bill-
central.aspx.

House Bill List: http://www.house.
mo.gov/content.aspx?info=/bills101/
billist.htm.

Senate Bill List: http://www.senate.
mo.gov/10info/BTS_Web/BillList.
aspx?SessionType=R.

Follow the Missouri Press on 
Twitter and “Like” the Missouri 
Press Association on Facebook, 
for information about upcoming 
events, contests and news!

Click the button to get MPA 
Tweets: http://twitter.com/Mis-
souriPress.

Go to Facebook and check 
the “like” button: http://www.
facebook.com/pages/Missouri-
Press-Association/1543758746175
99?sk=wall&filter=2. 

Follow Mo. Press
on Facebook, Twitter

Growth of online ads continues for websites

Newspaper sites get high trafficIf you have an interest in the 
history of your communty and your 
newspaper’s role in recording and 
preserving it, consider attending this 
program in Columbia.

The Newspaper Archive Summit 
will be held April 10-12 at the Rey-
nolds Journalism Institute in Colum-
bia.  (The meat of the program will be 
presented on Monday, April 11, for 
those who cannot attend the entire 
program.)

Historians, journalists and educa-
tors will explore ways to make sure 
your community’s history is preserved 
and how digital news is preserved.

Registration is free. The conference 
website is http://tinyurl.com/4ex6csx. 
If you have questions, contact Doro-
thy Carner at carnerd@missouri.edu, 
573-882-6591.

(telecomyatra, New Delhi)—The mobile channel now offers promise to brands 
as a non-intrusive medium for the targeted delivery of effective audio advertise-
ments.

While waiting for the called party to answer the phone, the caller listens to brand 
commercials instead of a regular ring or a caller tune. As soon as the called party 
answers the phone, the advertisement stops.

On average, there is a 15-second wait time before a call is answered. In these 15 
seconds, the caller is relatively undistracted, giving captive audience for brands. 
Messages delivered in this gap will be not only heard but also listened to. One day’s 
call volume alone in India can generate play time equivalent to approximately 40 
years.

StratosHear has launched this innovative model of delivering radio style adver-
tisements on mobile phones across India in partnership with mobile operators. This 
offering is an opt-in model and is available on all mobile phones regardless of the 
price. 

Consumers who choose the AdRBT (Advertisement ring back tone) service 
receive benefits from the Telco in return. As such, AdRBT represents an innovative 
model in which consumers benefit from being an active participant of the advertis-
ing channel.

Arlington, Va. – Newspaper websites saw tremendous traffic in the last year’s 
fourth quarter, drawing an average monthly audience of 105.3 million unique visi-
tors, 62 percent of all adult internet users. The analysis, performed by comScore 
for the Newspaper Association of America, also indicates that newspaper websites 
continue to attract key demographics, reaching 58 percent of 25-to-34-year-olds 
and 73 percent of individuals in households earning more than $100,000 a year on 
average throughout the quarter.

The findings also pointed toward audience engagement, with newspaper website 
visitors generating an average of 4.1 billion page views each month, spending nearly 
3.4 billion minutes browsing the sites.

“Newspaper websites stand out in today’s online environment, with trusted 
brands and high-quality journalism attracting an impressive audience that sets them 
apart from other players in the digital space,” said NAA President and CEO John 
F. Sturm. “As publishers continue to reinvent their business models, digital is at the 
forefront of a multiplatform transition that has seen steady growth in online adver-
tising revenue.”

Figures released by NAA recently indicate that online advertising generated $690 
million for newspapers in last year’s third quarter, a nearly 11 percent increase from 
the same period a year earlier.

Recent Scarbrough Research showed that more than 71 percent of adults read a 
newspaper in print or online in the last week. The company examined newspaper 
readership as part of its USA+ Study, a survey of more than 210,000 adults that 
captures media patterns and other consumer behaviors of adults across the country.

The latest data from Scarborough indicates that newspapers continue to attract 
consumers with buying power, with 80 percent of adults in households earning 
$100,000 or more reading a newspaper in print or online each week.

“Newspaper companies continue to leverage aggressive new business models to 
reach a substantial majority of adult consumers across print and online platforms, 
last week and every week,” Sturm said. 
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Add reporting punch
with CPI investigations

Online training

Inland Press Assn.
gets new executive

Check http://www.mopress.com/nt_training.php for links to the latest webinars from Inland Press and Online Media Campus.

Nameplate should be contemporary

Flag says a lot about you

Online Media Campus invites you 
to go to http://www.onlinemediacam-
pus.com to check out low-cost webi-
nars planned for the year. Here are the 
webinars currently scheduled:

-Social Media Ethics, April 7
-Return to Sales Basics, May 12
Missouri Press Association is 

among the more than 40 press asso-
ciations in the U.S. participating in the 
Online Media Campus program. 

Want to do a better job of marketing your newspaper? Have you taken a look 
at your nameplate recently? Do you know what it tells readers about you? Do you 
know what it sells readers about you?

If your nameplate isn’t clear, contemporary and compelling, it tells readers you 
don’t really care much about your product...and it certainly sells them less about 
you.

Why so much emphasis on the nameplate? Does it really matter that much? 
Yes.
Your nameplate is your statement—in every issue—of who you are, where you 

came from and what you stand for. If it’s poorly designed, it can actually put a 
damper on sales, especially in coin boxes.

Some tips:
SIMPLICITY: Your nameplate can go from bad to worse if you try to do too 

much with it. Remember that it’s telling your readers—and your advertisers—about 
your newspaper, what it stands for and its place in the community. A nameplate 
that’s over-designed appears frivolous. Keep it clean and contemporary.

COLOR: Using color in the nameplate is certainly an acceptable approach. But 
let’s make sure it’s there for a purpose. Gratuitous color makes a nameplate less than 
it can be, not more. You can use the color to make the town name stand out...or 
perhaps you want the name of your newspaper to be more prominent. It’s your call. 

ANCILLARY TYPE: Volume and number. Date. Price. A slogan. Number of 
pages. Number of sections. UPC code. Recycle logo. Location. Web address. Place 
all of that in and around your nameplate and it just becomes too much. Your name-
plate should be a thoroughbred—don’t turn it into a pack mule.

SIZE: Be careful about making the nameplate too large. If you do, it can tend 
to dominate the entire top of the front page. When I design a nameplate, I like to 
leave at least an inch of space on the sides. That space helps the nameplate to stand 
out a bit from the items surrounding it. Which leads us to... 

SPACE: Give the nameplate some breathing room. Closing in too tightly with 
other elements can create a mass in which the nameplate is lost. Even an aircraft 
carrier can disappear in port if it’s moored side-by-side-by-side with cruisers, de-
stroyers and escort vessels. Which leads us to...

TEASERS: If you’re placing teasers near your nameplate, it’s OK for teaser 
photos to go in front of/behind the name. But make sure this is done tastefully and 
with care. Be subtle. Be gentle.

TEASER PHOTO: Placement of the nameplate over a full-width teaser photo 
has become a more common approach during the past few years. It’s a device that 
can work well...again, if it’s done carefully. And it’s OK to reverse the nameplate 
occasionally if that helps. Easy does it. 

Want your nameplate to say good things about your newspaper? Treat it with 
respect, and it will.

WANT A FREE evaluation of your newspaper’s design? Just contact Ed:
edh@henningerconsulting.com | 803-327-3322.
IF THIS COLUMN has been helpful, you may be interested in Ed’s books: 

Henninger on Design and 101 Henninger Helpful Hints. With the help of Ed’s 
books, you’ll immediately have a better idea how to design for your readers. Find 
out more about Henninger on Design and 101 Henninger Helpful Hints by 
visiting Ed’s web site: www.henningerconsulting.com.

ED HENNINGER is an independent newspaper consultant and the Director of 
Henninger Consulting. Offering comprehensive newspaper design services includ-
ing redesigns, workshops, staff training and evaluations. E-mail: edh@henninger-
consulting.com. On the web: henningerconsulting.com. Phone: 803-327-3322.

Des Plaines, Ill.—Tom Slaughter, 
former vice president of U.S. Newspa-
per Markets for The Associated Press, 
recently was named Inland Press 
Association’s new executive director. 
Slaughter replaced Ray Carlsen, who 
served Inland as executive director for 
more than two decades.

Inland specializes in newspaper 
training and research.

Add some high-powered, relevant 
investigative journalism to your news-
paper. It’s FREE! 

The Center for Public Integrity 
provides in-depth stories that you are 
free to download and print in your 
newspaper or put on your website. Or 
you can link to the stories from your 
website. Go to http://www.publicin-
tegrity.org/.

Nomination forms for 
2011 Newspaper Hall 

of Fame, Missouri 
Photojournalism 
Hall of Fame and 

Outstanding Young 
Journalist 

are on the MPA 
website at 

http://www.mopress.
com/CURRENT_

FORMS.php.



Kevin Slimp

Institute of
Newspaper Technology
kevin@kevinslimp.com

When a newspaper or group contacts 
me to ask about training, they usually have 
something specifi c in mind. Th e client might 
be a publication moving to the InCopy/In-
Design workfl ow. Quite often, there’s a prob-
lem with print quality. No matter what the 
reason for my visit, it’s almost a certainty that 
I will be asked to give some advanced InDe-
sign training while on site.

When I fi rst started using InDesign, then 
known as “K2,” over 11 years ago, one of the 
fi rst things I noticed was how easy it was to 
learn the ins and outs of the application. It 
became apparent pretty quickly that there’s 
not a lot of “advanced” to InDesign. Th ere 
are just tools that users haven’t had the time 
to learn.

To this day, I get a kick out of seeing long-
time InDesign users smile when they learn 
how to create text in various shapes or to fi ll 
a letter of the alphabet with small text instead 
of a color. With that in mind, let me share an 
InDesign process that will save ad designers 
serious minutes when they’re laying out realty 
or auto ads. 

Th is task is accomplished using an InDe-
sign script. Scripts are little programs that 
allow users to accomplish tasks that would 
otherwise take much longer. Photoshop vet-
erans are used to using actions to get similar 
results.

Th ere are scripts to automate the creation 
of calendars in InDesign. One of my favorite 
scripts from the early days of InDesign was 
called “Pie Graph.” It allowed the user to cre-
ate a circle, enter a series of values, then sit 

back and have a snack while InDesign created 
a beautiful pie chart. Th e whole process took 
no more than a few seconds.

During a recent session of the Institute 
of Newspaper Technology, I asked a class of 
advanced InDesign students if anyone had a 
time-saving tip to share with the rest of the 
group. Emily, from Salem, Indiana, was quick 
to respond with a lesson on the “Make Grid” 
script in InDesign. Let me tell you how it 
works.

Th e goal of Make Grid is to create an 
area fi lled with frames to be fi lled with items. 
In our business, the best example might be 
the realty add that contains 15 to 30 house 
photos. Without Make Grid, most designers 
would probably create one frame, then dupli-
cate it throughout the page using guidelines 
or the “step and repeat” tool in InDesign. 
Make Grid speeds the process up signifi cantly 
and guarantees that your spacing is accurate 
throughout the area. Here’s how it works:

1. Create a frame (a rectangle) that fi lls 
the area where you want your photos to ap-
pear on the page. If you’re designing an auto 
ad with 15 cars, draw a frame (using your 
rectangle tool) where you want the 15 cars 
located on the page.

2. Select the frame with your se-
lection tool (black arrow) and go to 
Object>Fitting>Frame Fitting Options. Set 
Fitting to “Fill Frame Proportionately” and 
select the middle dot in the “Align From” op-
tion in the Frame Fitting Options window. 
Click OK to exit that window.

3. Next, go to the Scripts panel. In the 

most recent version of InDesign, it is found 
by selecting Window>Utilities>Scripts. In 
some earlier versions, you found this script 
by selecting Windows>Scripting>Scripts. 
You may have to look through the options 
under the Windows menu to fi nd “Scripts,” 
but it will be there.

4. Beginning with InDesign CS3, us-
ers will fi nd scripts already built into the 
Scripts menu. To fi nd them, look under 
Applications>Sample>Javascript in the 
Scripts panel. Prior to CS3, InDesign didn’t 
supply any scripts to go in the panel. Users 
can download scripts at no cost from Adobe.
com>Downloads>Exchanges. Click on the 
InDesign option to select from hundreds of 
scripts and plug-ins.

5. Double-click on the script “Make 
Grid.”

6. A window will appear on the screen, 
prompting the user to input the desired 
number of rows and columns, along with the 
space between them. After entering the num-
ber of columns, rows and gutters, click OK.

7. You should see the area fi lled with 
frames, ready to be fi lled with pictures of 
houses, cars or whatever. Go to File>Place 
and select the photos that you want to use. 
Click on each frame individually to fi ll it 
with one of the corresponding photos.

Th at’s it. You’ve now accomplished a task 
in a matter of seconds that would have taken 
several minutes without the use of the Make 
Grid script.

If you’re not already using scripts in In-
Design, you are about to fi nd out just how 
valuable they can be. A few other good ones 
to try in InDesign include “Split Story,” 
which allows the user to break jumps into 
separate stories, no longer linked together; 
“Image Catalog,” which creates a visual cata-
log of all the images in a designated folder; 
and “Sort Paragraph,” which alphabetizes a 
list of items.

So what are you waiting for?

Catch Kevin at an upcoming event:
Minnesota Tour (Mar 23-24)

Brookings, SD (Apr 8)

Des Moines, IA (Apr 15-16)

Jasper, IN (Apr 20-21)

Marksville, LA (Apr 29-30)

Invite Kevin to your 
newspaper or training event!

Learning new tricks in InDesign 
Using scripts to speed up your workflow

Man
vers

Gutter sizes are in points when you use the 
Make Grid tool. Remember that one inch 
equals 72 points.
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Download this ad and others to promote findings that political ads in newspapers are most 
helpful, most believable and least offensive: http://www.mopress.com/Election_Survey.php.

Job and Marketplace ads are posted to http://www.mopress.com/jobs.php as they come in. Check that site for the latest ads.

HELP WANTED

FOR SALE

Marketplace
Ads on this page are free to 

members of Missouri Press As-
sociation unless the ad is for an 
out-of-state newspaper. Cost to 
non-members and for member ads 
for newspapers out of the state is 
25¢ per word. 

Please email your ads to kford@
socket.net.

To check ads between issues of 
the Bulletin, go to mopress.com/
jobs.php.

CIRCULATION DIRECTOR:  Circulation Direc-
tor needed for Central Missouri Newspapers Inc. 
Excellent marketing, communications, leadership, 
organizational, team building, creative and ana-
lytical skills a must. Newspaper circulation back-
ground required. Qualified applicants please email 
resume to mvivion@newstribune.com.

SPORTS EDITOR: The Kirksville Daily Express, 
a six-day newspaper in northeast Missouri, has an 
immediate opening for a sports editor. This per-
son will be responsible for daily pagination of the 
sports pages, leading coverage of 11 area high 
schools and a Division II university, writing fea-
tures, editing, some photography, and more. The 
ideal candidate will have a bachelor’s degree in 
journalism or a related field, as well as experience 
with QuarkXPress. This position also involves 
making consistent Internet updates and usage of 
social media tools. Send your resume and sam-
ples of writing and pagination work to Jason Hun-
sicker, Managing Editor, Kirksville Daily Express, 
P.O. Box 809, Kirksville, MO 63501, or e-mail at 
dailyexpresseditor@gmail.com. No phone calls, 
please. 3-2 
 
MARKETING REP: The National Newspaper As-
sociation is looking for someone who believes in 
newspapers to join the NNA Marketing Council as 
a representative for this region. We need some-
one who is connected and who wishes to stay 
connected to the industry in Missouri, who be-
lieves that community newspapers are the heart 
and soul of their towns, cities and counties, some-
one who wishes to build the newspaper industry. A 
representative’s role will be to contact newspaper 
editors and publishers and tell them about NNA 
and why we can help their newspapers, their com-
munities and their industry. If you’re that person, 
give us a call and tell us what you’re thinking. 
Marketing Council reps will have flexibility to de-
sign their own plans. We offer an expense stipend 
payable when the plan is accepted, and a good 
commission based on results. For more informa-
tion contact Lynn Edinger at NNA, lynn@nna.org, 
573-777-4980.  

GENERAL MANAGER: An immediate position is 
available for General Manager of The Marshfield 
Mail and South County Mail. This person would 
manage all departments of the newspaper. Special 
emphasis is placed on editorial direction now, but 
the job can be structured to match the greater 
strengths of the successful applicant. These two 
weekly newspapers located in southwest Missouri 
are part of the Neighbor Newspaper organization, 
with sister papers completing a circle around 
Springfield. Good benefits are included in the 
company support for providing outstanding 

service to these communities via print and online 
publications. Please respond with resume to: 
Janie Terrell, Human Resources, P.O. Box 330, 
Bolivar, MO, 65613; fax to 417.326.8701; or email 
at janiet@Mo.NeighborNews.com. EOE.  

PUBLISHER: The Parsons Sun is currently in 
search of an enthusiastic leader. Experience in 
the newspaper industry with a proven track record 
a must. Our leader must demonstrate team-
building skills, be customer driven and represent 
the newspaper in the community. Experience 
in advertising management preferred. We are 
independently owned and offer competitive salary 
with bonus plus full benefits. Send a detailed 
resume with professional and personal references 
to: brucewallace03@gmail.com.

REPORTER: Full-time position for a staff reporter 
at the Higginsville Advance to cover local meetings 
and functions (some evenings). Approx. 50 miles 
east of Kansas City. Experience in Photoshop, 
pagination and InDesign. Send resume to 
higvladv@ctcis.net. No phone calls please.

  N. MO. WEEKLY: Locally owned, hometown 
weekly newspaper in La Plata, Missouri. 1,000 
circulation. Mostly farm and rural area oriented. 
Homey, small “mom and pop” paper. Kids are 
grown and gone, time for me to do the same. If 
interested please call Becky at 660-651-9704 
or The Home Press at 660-332-4431 for more 
information.

Newspapers have 
significantly increased 

their perception as being 
the Most Helpful political 
ads; going from 12% in 
2002 to 21% in 2010.

       Radio Ads  3.8%
       TV   13.5%
       Brochures   9.3%

All remained consistantly stable

2010 Post-Election Pulse 
Research Survey

Newspaper

READERS

Are VOTERS

The Missouri Press Service can help you make newspaper advertising a 
central part of your campaign. MPS offers access to hundreds of newspapers 
across the state. We do the work of ad placement for you. Contact us to find 

out how MPS can help you target your newspaper campaign.

The Missouri Press Service will get your message directly to the voters.

For more information contact Greg Baker
Advertising Director

573.449.4167
gbaker@socket.net

Successful Campaigns
Leave a Paper Trail

Media Most Helpful Most Believable Most Offensive

Newspapers

Television

Radio

21% 19% 3%

14% 7% 54%

4% 4% 2%

21%

Successful Campaigns
Leave a Paper Trail



Social media is an important tool in business today. At the very least, you need to be aware of the revolution. 

Ideally, you could be using it to your advantage.  

This training offers you:
• Social Media 101- the basics, the options and the reason for the social media explosion.

• The impact social media is having on the advertising world.

• Opportunities for your newspaper to use social media and the internet to increase readership.

• Ways to generate revenue through social media and the internet.

Missouri Press Foundation is bringing the these workshops to you. One great training in two locations.

 71% of companies used Facebook in 2010      
        59% of companies use Twitter
50% of companies are blogging
 86% view social media to be important to their business and marketing strategy

If you are on the 
outside looking in, 
you need this   
training.

Friday, April 29 in Warrensburg
Friday, May 6 in Lebanon
9:30 a.m. to 3 p.m.

$40 registration fee, $60 after deadline
Registration includes lunch

Visit www.mopress.com or call (573)449-4167 to register.  Brought to you by the Missouri Press Foundation 
with support from the Warrensburg Daily Star-Journal and  The Lebanon Daily Record.

Friday, April 29 in Warrensburg
Holiday Inn Express, 626 E. Russell Ave.

Regular Registration Deadline: April 15

Friday, May 6 in Lebanon
Kenneth Cowan Civic Center, 500 E. Elm.

Regular Registration Deadline: April 22

* Stats from University of Massachusetts Dartmouth Center for Marketing Research 



 

Name 

Newspaper

Address

City            ZIP

Phone                 FAX

E-mail

Additional Registrants:

          

Registration Registration 

RECEIPT OF REGISTRATION: We will 
send a confirmation e-mail to confirm this 
registration. If you do not receive this, 
please call Kristie Williams at 573-449-
4167.

Cancellation Policy: No refunds will be 
given if a cancellation is made less than 
72 hours prior to the session.

Credit card # ________________________________ Exp. ___/___    
                                      VISA/Mastercard only

Address _________________________________ ZIP __________
                      must be address/zip where billing is sent

Amount to be charged $_____________  Date _________________

Authorized signature _____________________________________

   ___ Payment enclosed ___Charge my credit card (see below)

Mail form and payment to: Missouri Press Foundation, 
802 Locust, Columbia, MO 65201 or FAX 573-874-5894

      
Darren Heckman is 
president of High 5 
Communications in 
Jefferson City.  

High 5 Communica-
tions is a market-
ing, public relations 
and planning firm    
serving clients in 

the   retail, healthcare, education and as-
sociation industries.

Darren received his Bachelor’s Degree 
in Public Relations from Central Missouri 
State University (now University of Central 
Missouri). 

Prior to starting High 5 in July of 2006,  Dar-
ren spent nine years in Marketing/Public 
Relations at Capital Region Medical Center 
in Jefferson City.  

Darren Heckman

The Trainer
I WILL ATTEND THE SOCIAL 

MEDIA TRAINING:

______ Friday, April 29 in Warrensburg
$40 per person ($60 after April 15 deadline)

______ Friday, May 6 in Lebanon
 $40 per person ($60 after April 22 deadline)

Thanks to the Warrensburg Daily Star- 
Journal and The Lebanon Daily Record 
for helping sponsor this training in their 
communities.



Register today! Training opportunities
for your Graphics AND Sales staff!

Missouri Advertising MAnAgers’ AssociAtion
Holiday inn Kansas city se Water Park Hotel
9103 East 39th Street, Kansas City, MO 64133
Hotel Phone (816) 737-4725

Learn practical, real world solutions from TWO newspaper professionals!

Missouri Advertising Managers Association • 802 Locust • Columbia, MO 65201 • Phone: 573-449-4167 • Fax: 573-874-5894

[

[

Thursday, April 14

  11:00 am - Noon  MAMA Board Lunch Meeting in hotel at Tradewinds Restaurant  
  Noon - 1:00 pm  Registration in Hotel Lobby
  1:00 pm - 5:00 pm Speaker Tim Smith
  1:00 pm - 2:15 pm Sales By Numbers
  2:15 pm - 2:30 pm Refreshment Break
  2:30 pm - 3:45 pm Time and Territory Management
     • The Four Step Planning Process
     • GOALS
     • Customer Spreadsheet

  3:45 pm - 5:00 pm Communication Skills
     • The Factors of Communication
     • Listening Skills
     • Understanding Different Personalities
     • Selling to the Different Styles

  6:30 pm - 8:00 pm Dinner Presentation of the 2011 MAMA Contest Awards

Friday, April 15

  8:00 am - 8:45 am Breakfast & Presentation on Atomic News Tools 
  8:30 am - 11:00 am Registration - Hotel Lobby 
  8:45 am - Noon Speaker Russell Viers
  8:45 am - 10:30 am Using Creative Suite 4 to Create Eye Catching Spec Ads
     & Using Creative Shapes to Increase Advertising Revenue
  10:30 am - 10:45 am Refreshment Break
  10:45 am - Noon Online Advertising is NOT Print Advertising

Tim Smith

Featured Speaker

Russell Viers

Featured Speaker



Please return this form along with check or credit card information to 
Missouri Advertising Managers Association  •  802 Locust St.  •  Columbia, MO  65201  •  573-449-4167  •  Fax: 573-874-5894  •  kwilliams@socket.net

Missouri Advertising MAnAgers’ AssociAtion
Annual Conference Registration • Thursday April 14 and Friday April 15, 2011

Holiday inn Kansas city se Water Park Hotel
9103 East 39th Street, Kansas City, MO 64133

Room rate: $99 • Reserve your room by calling 816-737-4725
Sleeping room reservations must be made by Friday, March 11

Ask for Missouri Press Association - MAMA Conference

Please write names of people who will attend from your newspaper or organization and mark the events/sessions they will attend. 

Name

Full 
Registration

By
3/18/11
$129

Full 
Registration

After
3/18/11
$139

Thursday Only
Afternoon
Sessions

$40

Thursday
Dinner &
Awards

Ceremony
$60

Friday Only 
Package

Includes Breakfast 
& AM Session

$40
Total Per 
Person

CONVENTION CANCELLATIONS: CANCELLATIONS RECEIVED By FRIDAy, MARCH 25, 2011, WILL BE ENTITLED TO A REFUND.  CANCELLATIONS MAy BE FAxED TO 573-874-5894 OR 
EMAILED TO KWILLIAMS@SOCKET.NET.  CANCELLATIONS RECEIVED AFTER FRIDAy, MARCH 25, 2011, ARE NOT ENTITLED TO A REFUND.

Grand Total
Name of Newspaper:

r Check Enclosed - Please make checks payable to MAMA

r Mastercard  r Visa          Credit Card No.        Exp. Date 

Name on Card           Signature

Address:

Contact Email:



Build Your N
ew

spaper Faster 
Using InD

esign and Photoshop

You’ll learn tools and techniques in this w
orkshop

 
that could save you hours each w

eek b
uilding p

ages 
and ads. O

ver the w
hole year that’s signifi cant, esp

e-
cially if you’re p

aying overtim
e.

This is not just for users of C
S4. M

any of the  features 
covered are availab

le in m
any versions.

To register, contact M
issouri Press Foundation at 

573-449-4167 or fax a registration form
, availab

le at 
w

w
w

.m
op

ress.com
. 

Som
e of w

hat you’ll learn:
•

 Building ads faster in InD
esign

•
 Processing photos faster for best 

    reproduction
•

 Building a tem
plate that cuts 

    production tim
e

•
 Building editorial pages faster in InD

esign
•

 Autom
ating m

undane, repetitive w
ork

•
 Using W

ord to form
at copy for InD

esign
•

 Im
proved w

orkfl ow
 ideas

•
 M

astering Styles for speed, consistency 
    and quick editing
•

 Tapping into the pow
er of Libraries 

    and Snippets
•

 H
ow

 InD
esign’s D

ata M
erge could change    

    your life
•

 G
R

EP styles and how
 they cut editing tim

e
•

 Editing copy faster through autom
ation

•
 Using Bridge for faster photo handling

•
 M

uch, m
uch m

ore

You’ve had the softw
are 

for years and you do 
the sam

e thing over and 
over, w

eek after w
eek, 

thinking, “There m
ust 

be a better w
ay.” 

There is.
R

ussell Viers, International 
A

dobe C
ertified Instructor, 

w
ill teach you how

.

Friday, April 1
9 a.m

. to 4 p.m
.

B
arton Co. Am

bulance D
istrict B

ldg.
Conference Room

, 1100 Cherry St., Lam
ar

Registration is just $35 

In
D

esig
n

 
              Fo

r A
b

so
lu

te B
egin

n
ers

This class assum
es you know

 nothing ab
out 

InD
esign and starts at the very b

eginning.

The goal is to teach you the m
ost b

asic concep
ts 

to you can b
egin b

uilding ads and editorial p
ages 

w
ith success. 

W
ith the techniques taught in this class you’ll b

e 
on your w

ay to b
ecom

ing an exp
ert. 

This class w
ill m

ove as slow
ly as the attendees 

need to m
aster these techniques:

A
d

ob
e exp

ert Russell V
iers 

w
ill sh

ow
 you th

e w
ay.

Thu
rsd

ay, M
a

rch
 31

9 a.m
. to

 4 p.m
.

Barton Co. A
m

bulance D
istrict  Bldg.

Conference Room
, 1100 Cherry St., Lam

ar

R
eg

istratio
n

 is ju
st $35 

D
o

 yo
u

 feel a little lo
st b

y In
D

esig
n

?
 A

re yo
u

 g
ettin

g
 read

y to
 co

nvert fro
m

 
Q

u
arkX

Press o
r Pag

eM
aker? 

A
re yo

u
 n

ew
 to

 co
m

p
u

ter p
ag

in
atio

n
? 

To register, contact the M
issouri Press 

Foundation at 573-449-4167 
or fax a registration form

, 
availab

le at w
w

w
.m

op
ress.com

. 

• W
hat is InD

esign
• The Interface 
• Creating a N

ew
 D

ocum
ent

• W
orking w

ith Text
• Placing and Sizing graphics
• M

argins and Colum
ns

• W
hat is a tem

plate?
• W

orking w
ith color

• Text W
rap

• Introduction to Styles
• O

utputting your pages

... and m
uch m

ore as tim
e allow

s.

Tw
o InD

esign Trainings in O
N

E LO
C

ATIO
N

!
Join R

ussell Viers in Lam
ar, M

issouri!



 
Name 

Newspaper

Address

City             ZIP

Phone                  FAX

E-mail

Additional Registrants

REGISTRATION RECEIPT: 
To assure receipt of this registration, 
we will send a confi rmation e-mail. 
If you do not receive this, please call 
Kristie Williams at 573-449-4167.

Cancellation Policy: No refunds if 
cancellation is less than 72 hours prior 
to the session.

TOTAL: ___________                 Payment enclosed ___    Charge my credit card ___ 

Mail form and payment to: Missouri Press Foundation, 
802 Locust, Columbia, MO 65201 or FAX 573-874-5894

WORKSHOP REGISTRATIONS
Russell Viers in Lamar, Missouri!

Russell Viers is an Adobe Certifi ed Instructor who travels the world teaching production 
techniques to save time and improve quality. And even though he works with some of 
the largest newspapers in the world, his fi rst love is small community newspapers.

Who is this
Russell Viers?

Credit card # ___________________________________ Exp. _____/____    
                                      VISA/Mastercard only

Address ______________________________________ ZIP ____________
                      must be address/zip where billing is sent

Amount to be charged $______________  Date _____________________

Authorized signature ____________________________________

� InDesign for Absolute Beginners, Thursday March 31, Cost: $35

� Build Your Newspaper Faster Using InDesign & Photoshop, 

 Friday, April 1, Cost: $35

� ATTEND BOTH! Discounted Registration for Both Trainings: $5O


